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1.0 About Pocket WinLoG

Pocket WinLoG can be used to collect boring and well information in
the field with a minimum of data entry. After the data has been col-
lected it can be uploaded or emailed to a desktop computer and
imported into WinLoG.

This method of data collection eliminates the need to record boring
and well information on paper forms in the field and then enter the
data into WinLoG at the office.

By entering the data directly into Pocket WinLoG you can:

- reduce the time required to copy the paper forms into WinLoG,

- reduce errors caused when reading and entering paper forms at the
office,

- ensure more complete and accurate collection of data in the field,

- email data from remote sites to the office, and

- backup field data electronically.

As in the desktop version of WinLoG, the program is designed around
the project concept for storing log data. This concept allows the user
to have numerous projects and an unlimited number of logs within
each project. When it is time to upload the log data to the desktop ver-
sion of WinLoG, the data can be imported on a log by log basis or an
entire project at once.

The types of data collected for a boring or well log are controlled by
the template. These templates are the same as those used in the desk-
top version of WinLoG, and can be downloaded from the desktop ver-
sion at any time. The template specifies the types of general borehole
data (header and footer data), sample other data, remark, well, and
graph data. In general all of the boring and well logs in a project would
use one or two templates, creating a consistent data format for the
project.
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To minimize the amount of data entry for a boring and well log, lithol-
ogy and well macros can be created on the desktop and downloaded to
Pocket WinLoG.

Lithology macros are used to insert previously defined text and sym-
bols into a lithologic layer. By using lithologic macros, layer descrip-
tions can be entered quickly and easily.

Well macros are used to insert previously defined well construction
details into a boring log. These macros can contain well components,
water levels, and annotation. By using well macros, detailed well con-
struction diagrams can be entered very easily into a log. In general,
most well information can be entered this way and only the depths will
need to be changed.

In order to avoid losing any data during field collection, all data is
saved as it is collected. To reduce storage space requirements, all data
is stored in binary files.

2.0 Entering Data in Pocket WinLoG

As in the desktop version, the Pocket WinLoG program is designed
around the project concept for storing log data. This concept allows the
user to have numerous projects and an unlimited number of logs with-
in each project.

When it is time to upload the log data to the desktop version of
WinLoG, the data can be imported on a log by log basis or an entire
project at once. Before entering boring log data into Pocket WinLoG a
project must be either opened or created. The opened or created proj-
ect is then referred to as the current project.
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To enter the new boring data a boring log should be created within the
current project, or to edit existing boring data a boring log should be
opened.

2.1 Creating a Project

To create a project, select the New Project menu item from the File
menu. A new project form will be displayed where you can enter the
project name (up to 100 characters). This name must be unique. To
assist the entry of a unique name a list of all of the existing projects
are displayed below the name entry field.

2.2 Opening a Project

To open an existing project, select the project from the open project
form that is displayed when the program is started or when the current
project is closed. The project can be selected by touching it with the
stylus.

When the project is opened a list of existing logs in the project will be
displayed. After a project has been opened it can be closed by select-
ing the Close Project menu item from the File menu.

2.3 Deleting a Project

To delete a project select the Delete Project menu item from the File
menu. The delete project form will be displayed showing a list of
existing projects. Select the project to be deleted from the list.

If the Delete Project menu item is not available make sure that there is
no project currently open.
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2.4 Creating a Boring Log

To create a new boring log in the current project select the New Log
menu item from the File menu. A new log form will be displayed where
you can enter a unique name for the log (up to 100 characters).

To assist you in specifying a unique name, a list of existing logs in the
project is displayed. After the unique name is entered and the Ok but-
ton is pressed the Select Template form will be displayed. Select a tem-
plate to use for the log by clicking on it.
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The template determines the types of data included in the log. These
templates are created on the desktop version of the program and down-
loaded to the Pocket PC.

When the boring log is created a menu tree will be displayed showing
the different types of data that can be entered. The boring log data can
be entered and edited by selecting the data type from the menu tree. If
the New Log menu item is not available make sure that a project is
currently open and that no boring log is opened.
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2.5 Opening a Boring Log

To open an existing boring log, select the log from the open borehole
log form that is displayed when a project is opened or when the current
boring log is closed. The boring log can be selected by touching it with
the stylus.

When the boring log is opened a menu tree will be displayed showing
the different types of data that can be entered. The boring log data can
be entered and edited by selecting the data type from the menu tree.

After a boring log has been opened it can be closed by selecting the
Close Log menu item from the File menu.

2.6 Entering Boring Log Data

When the boring log is opened or created a menu tree will be displayed
showing the different types of data that can be entered. The types of
data are determined from the template that was selected when the log
was created.

This menu tree is used to enter and edit the data by selecting the type
of data from the tree. Some menu items in the tree use sub-menus to
further break down the type of data (e.g. "Borehole Data").

When there is a sub-menu, a sub-menu item must be selected (e.g..
"Number & Depths") and selecting the main menu item will have no
effect.

The following types of data can be entered:

- General Borehole Data
- Lithology
- Sample Data
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- Well Data

- Remark Data

- Graph Data

- Water Content Data
- Core Data

- Notes

E.i] winLoG 1:08p
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2.6.1 General Borehole Data

The General Borehole Data for a log includes information about the
borehole number, X and Y coordinates, well symbol, text and memo
information. Text and memo information can include data such as proj-
ect name, location, client, drill date, drill method, etc.

This data is usually displayed in the header or footer of the log. The
template selected when the log was created will determine the types of
information that can be entered for the General Borehole Data.

There are three types of data that can be entered under the General
Borehole Data item on the menu tree.

- Number and Depths
- Data
- Memos

General Data: Number and Depths

When the Number & Depths menu item is selected, the following
information can be entered:

Borehole Number: This is the unique borehole number (up to 100
characters).

Start Depth: This is the starting depth of the borehole (normally zero).
To enter a borehole with an aboveground casing a negative Start Depth
should be entered. The units can be either feet or meters depending
upon the template settings. The depth can also be changed using the up
and down arrows on the right.
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End Depth: This is the bottom depth of the borehole in the same units
as the start depth. There is no limit to the depth of a
borehole.Elevation: The elevation of the ground surface at the bore-
hole in the same units as the start depth.

X-Coordinate: The X coordinate of the borehole location. The units
of the coordinates should be the same as the Y coordinate.

Y-Coordinate: The Y coordinate of the borehole location.

. WinLoG 1:10p
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General Data

When the Data menu item is selected a form will be displayed with the
general types of data for the borehole. These data types are specified in
the template. The borehole specific data (up to 256 characters) for each
type is shown on the right side of the list.

To enter or edit the data for a type click on the line containing the data.
The entry field at the top of the form can then be used to enter the new
data. To store the changed data click on a different data type or on the
Ok button.
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General Memo Data

When the Memos menu item is selected a form will be displayed with
the general types of memo data for the borehole. These data types are
specified in the template. The borehole specific data for each type is
shown on the right side of the list. There is no limit to the length of
the memo text that can be entered. Enter or edit the data for a type
directly into the memo field on the form. To move to the next or pre-
vious memo type use the buttons at the bottom of the form.

2.6.2 Lithology

Lithologic layers are used to indicate the subsurface strata encoun-
tered during drilling. Boreholes can contain an unlimited number of
lithologic layers.

The lithology for a boring log can be entered by selecting the
Lithology menu item from the menu tree. A Lithology form will be
displayed with two tabs. The first tab is used to specify the depths and
lithology of the layer and the second tab is used to select the litholog-
ic symbol.

On the toolbar at the bottom of the tabs are buttons that can be used to
move to the previous and next layers, add a layer, or remove a layer.

Lithology Tab
The following information can be entered on the Lithology tab:
Top Depth: This is the depth to the top of the layer in the same units

as the depth of the borehole. The depth can also be changed using the
up and down arrows on the right.
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Bottom Depth: This is the bottom depth of the layer. If it is zero then
the top depth of the next layer is used as the bottom depth.
Name: The optional name of the layer (up to 255 characters).

Description: This is the description of the layer.

Contact Angle: The contact angle between this layer and the layer
above, where zero is a horizontal contact and 90 is a vertical contact.

Lithology Macro: This button is used to select a lithology macro for
the layer. When it is pressed a list of macros will be displayed. Each
macro contains a name/title, description, and symbol. When a macro is
selected it will be used to fill in the information for the layer.

E.i] WinLoG 1:17p
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Symbol Tab

On the Symbol tab the following information can be entered:
Library: This combo box is used to select the symbol library for the
layer. When the arrow at the right is pressed a list will display the

available symbol libraries.

Symbol: The symbol for the layer can be selected by clicking on one
of the 18 symbols of the current library.

E.] WinLoG 1:19p
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2.6.3 Sample Data

Soil, rock, ice and other samples are generally taken at various depths
of the borehole. These samples are later used for detailed identification,
lab analysis, and other purposes. An unlimited number of samples can
be entered in Pocket WinLoG.

To enter the sample information click on the Sample Data menu item
of the menu tree. The Sample form contains two tabs one for typical
information collected for a sample and the other for additional user-
defined data.

On the toolbar at the bottom of the tabs are buttons that can be used to
move to the previous and next samples, add a sample, or remove a sam-
ple.

Sample Tab
The following information can be entered on the Sample tab:

Sample Number: This is an optional sample number (up to 255 char-
acters). The number can contain text characters.

Start Depth: This is the start depth of the sample in the same units as
the depth of the borehole. The depth can also be changed using the up
and down arrows on the right.

Length: This is the length of the sample. Initially when a sample is
added the default length is used.

Type: This is the optional type of sample (up to 255 characters).
Blows/ft: This is the blow count or N-Value for the sample (up to 255

characters). When entering the blow counts a line break can be added
between values by specifying a "/" between data values.
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Recovery: This is the sample recovery, usually expressed as a per-
centage or length.

Symbol: This is the optional symbol used to represent the sample.
When the symbol button is pressed a list will be displayed showing the

types of symbols that can be selected. After a symbol has been select-
ed the list will disappear.

£ WinLoG 1:20p
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Other Tab

The Other tab is used to enter user-defined types of data for the sam-
ple. The number of other data types and the names used for this data
is defined by the template used to create the log. All other data is
stored as text strings (up to 255 characters each).
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To enter or edit the sample other data, click on the line containing the
data. The entry field at the top of the form can then be used to enter the
new data.

2.6.4 Well Data

A wide variety of wells can be input using Pocket WinLoG; including
monitoring, extraction, injection, and multiple piezometer wells.
Borehole logs can contain an unlimited number of wells. All of the
wells input into Pocket WinLoG are Type 3 wells, which allows for the
greatest degree of flexibility and complexity.

The wells to include with a borehole are normally determined by the
template and the datasets are automatically added. Additional wells can
be added or deleted using the Add Well and Delete Well menu items.

Adding a Well

When the Add Well menu item is selected a form will be displayed
where you can specify the well name. In order for this well to appear
on the borehole log in the desktop version of WinLoG, there must be a
column in the template that matches the well name.

Deleting a Well

To delete a well dataset select the Delete Well menu item. Select the
well to be deleted from the list of the well datasets for the log.

Entering Well Data
To enter or edit the data for a well, click on the well name on the menu

tree. The well data form displayed contains three tabs for Components,
Water Levels, and Annotation.
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At the bottom of the form is a field to enter the Well Diameter, a Well
Macros button, and a toolbar. The well diameter should be the outside
diameter of the drill hole. On the toolbar are buttons that can be used
to add or delete a component, water level, or annotation depending on
which tab is selected.

Well Macros

The Well Macros button is used to select a well macro for the well.
When it is pressed a list of macros will be displayed. Each macro con-
tains components, water levels, and annotation. When a macro is
selected it will be used to fill in the information for the well. This
method enables detailed well descriptions to be entered quickly and
easily. All that needs to be changed are the depths and water levels.

Components Tab

The following information can be entered on the Components tab:
Component: This is the type of well component. The types of com-
ponents that can be selected are cover, cap, joint/misc., casing/screen,
seal/packing and bottom seal.

Start Depth: This is the start depth of the component in the same units
as the depth of the borehole. The depth can also be changed using the
up and down arrows on the right.

End Depth: This is the end depth of the component.

Inner Diameter: This is the inner diameter of the component. It is
only used for seal and some casing/misc. components.

Outer Diameter: This is the outer diameter of the component. It is
used by all of the types of components.
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Symbol: This is the symbol to use for the component. When the sym-
bol button is clicked a list of component symbols will be displayed.
This list will change depending on the type of component. Select the
desired symbol by clicking on it.

E. WinLoG 1:30p
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Water Levels Tab
The following information can be entered on the Water Levels tab:

Depth: This is the measured depth of the water level in the same units
as the borehole depth.
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Text: This is the text (up to 255 characters) to display above the water
level symbol.

Symbol: This is the symbol to use to represent the water level.

E.i] WinLoG
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Annotation Tab

The following information can be entered on the Annotation tab:
Text: This is the annotation text (up to 255 characters).

Start Depth: This is the start depth to display the annotation. The text

will normally be positioned below the start depth.
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End Depth: This is the end depth for the annotation. The text will nor-
mally be positioned above the end depth.

Symbol: This is the symbol to use to draw the text leaders.

[ Components ] W aker Levelsl Anotation l -

Teut: | 2" Slot 20 Screen |
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2.6.5 Remark Data

Remark data can be used to display any information that varies with
depth; such as soil classification, RQD, chemical or physical tests,
drilling rates, etc. Boring logs can contain an unlimited number of
remark columns.
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The remarks to include with a borehole are normally determined by
the template and the datasets are automatically added. Additional
remarks can be added or deleted using the Add Remark and Delete
Remark menu items.

The "Description" remark is added to all logs and any text or memos
entered in this dataset will appear in the Lithology column of the log.

Adding a Remark

When the Add Remark menu item is selected a form will be displayed
where you can specify the remark name. In order for this remark to
appear on the borehole log in the desktop version of WinLoG, there
must be a column in the template that matches the remark name.

Deleting a Remark

To delete a remark dataset select the Delete Remark menu item. Select
the remark to be deleted from the list of the remark datasets for the log.

Entering and Editing Remarks

To enter or edit the data for a remark, click on the remark name on the
menu tree. The remark data form displayed contains two tabs for Text
and Memos. Remarks can contain both text and memos. The differ-
ence between them is that text is limited to 255 characters; whereas,
there is no limit to the length of a memo.

Both tabs can be used to enter the depth and text for the remark. The
depth can also be changed using the up and down arrows on the right.
On the toolbar at the bottom of the form are buttons that can be used
to move to the previous and next remark, add a remark, or remove a
remark.
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2.6.6 Graph Data

Graph data can be used to display any numerical information that
varies with depth; such as, shear strength, water content, hydraulic
conductivity, etc. Graphs can be either single data point graphs or bar-
graphs. The type of graph is specified when the graph dataset is creat-
ed.

The graphs to include with a borehole are normally determined by the
template and the datasets are automatically added. Additional graphs
can be added or deleted using the Add Graph and Delete Graph menu
items.
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Adding a Graph

When the Add Graph menu item is selected a form will be displayed
where you can specify the graph name and whether it is a bargraph. In
order for this graph to appear on the borehole log in the desktop ver-
sion of WinLoG, there must be a column in the template that matches
the graph name.

Deleting a Graph

To delete a graph dataset select the Delete Graph menu item. Select the
graph to be deleted from the list of the graph datasets for the log.
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Depth | Walue
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Single Point Graphs

If the graph type is for single points the Graph form will contain a list
of the depths and values. To edit an existing graph depth or value click
on the data point and edit its values in the fields at the top of the form.

Bargraphs

If the graph type is bargraph, the Graph form will contain a list of the
top depth, bottom depth, and value for each point. To edit an existing
graph depth or value click on the data point and edit its values in the
fields at the top of the form.

On the toolbar at the bottom of the form are buttons that can be used to
move to the previous and next graph point, add a graph point, or
remove a graph point.

2.6.7 Water Content Data

Water contents and Atterberg limits can be entered by selecting the
Water Content Data menu item from the menu tree. A Water Content
form will then be displayed.

On the toolbar at the bottom of the form are buttons that can be used to
move to the previous and next data point, add a data point, or remove
a data point.

The following information can be entered:
Depth: This is the depth of the measurement in the same units as the
depth of the borehole. The depth can also be changed using the up and

down arrows on the right.

Water Content: This is the measured water content.
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Plastic Limit: This is the measured plastic limit.

Liquid Limit: This is the measured liquid limit.

E. WinLoG 1:40p
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2.6.8 Core Data

Core data is used to represent lithologic samples collected in a bore-
hole that do not necessarily correspond to lithologic layers. To enter
core data select the Core Data menu item from the menu tree.
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The following data can be entered on the Core Data form:
Top Depth: This is the top depth of the core sample in the same units
as the borehole depth. The depth can also be changed using the up and

down arrows on the right.

Bottom Depth: This is depth to the bottom of the core sample. If it is
set to zero the top of the next sample will be used.

Library: This is used to select the symbol library for the core sample.

When the arrow at the right is pressed a list will display the available
symbol libraries.

E.] wWinLoG 1:45p
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Symbol: The symbol for the core sample can be selected by clicking
on one of the 18 symbols for the current library.

On the toolbar at the bottom of the form are buttons that can be used
to move to the previous and next core sample, add a core sample, or
remove a core sample.

2.6.9 Notes

Notes are used to add additional information for the boring log. These
notes will be converted to paragraph text when the log is uploaded to
the desktop version of WinLoG. The location of the note on the log can
be added after it has been uploaded to the desktop.

To add notes to a log select the Notes menu item from the menu tree.
The Note form can then be used to enter the additional information.

On the toolbar at the bottom of the form are buttons that can be used
to move to the previous and next note, add a note, or remove a note.
2.7 Saving a Boring Log

All boring log data is saved as it is entered, so there is no need to
explicitly save the data. When entering the data on a form it is saved
whenever the Ok button is pressed on the toolbar.

2.8 Deleting a Boring Log

To delete a boring log select the Delete Log menu item from the File

menu. The delete borehole logs form will be displayed showing a list
of existing logs. Select the log to be deleted from the list.
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If the Delete Log menu item is not available make sure that there is no
boring log currently open and that a project is open.

3.0 Synchronizing Pocket WinLoG

Pocket WinLoG can be synchronized with the desktop WinLoG on
your PC. Synchronizing Pocket WinLoG will make sure that any data
created in Pocket WinLoG is copied to the desktop. In addition, any
template or macros exported in WinLoG will be available to Pocket
WinLoG.

When you update a file on either your PC or your device, the file is
updated in the other location the next time you synchronize.

The process of synchronization is performed by ActiveSync, which
must be running on the desktop computer. This program is usually pro-
vided with the pocket PC.

To have ActiveSync synchronize files, first select the Files information
type for synchronization in ActiveSync.

When you select Files, a folder called “Pocket PC My Documents” is
created on the desktop.

When Pocket WinLoG is installed the data files are automatically
stored in the “Winlog” subfolder of the “My Documents” folder on the
Pocket PC.

In order to exchange data with the desktop version of WinLoG, the
“Pocket WinLoG Directory” in the programs Preferences must be set
to the “Winlog” subfolder of the “Pocket PC My Documents” folder.
This folder is usually located in “c:\My Documents” on Windows 98
systems or in “c:\Documents and Settings\USERNAME\My
Documents” on Windows 2000 and NT systems.
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For more information on synchronization or file conversion, see
ActiveSync Help on the PC.

3.1 Uploading Boring Data to the Desktop

The uploading of data from the Pocket PC to the desktop is performed
automatically during the synchronization process. If the data is to be
emailed, the files in the “Data” subfolder should be emailed.

To import the uploaded data into WinLoG, run WinLoG and select the
Import Logs menu item from the Pocket PC Data submenu of the File
menu. The Import Pocket PC Data form will be displayed. This form
shows the projects and the logs for each project on the Pocket PC.

Import Pocket PC Data

Current Packet Projects Current Logs Import Project

Tutorial 121 _
Samples a2 Mew Project
a3

Exizting Project

i

—Import Log

[ ews Project

Exigting Project

x Cancel

P Help

iR |
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There are several ways to import the log data. The data can be import-
ed for an entire project or for an individual log. This data can either be
added to a new project or an existing project.

If the data is to be imported into a new project, the New Project form
will be displayed after the button is pressed. Enter the project informa-
tion and press the Ok button to import the data.

If the data is to be imported into an existing project, the Open Project
form will be displayed after the button is pressed. Select the project and
press the Ok button to import the data.

3.2 Downloading Templates

One or more templates in WinLoG can be exported and downloaded to
Pocket WinLoG by selecting the Export Templates menu item from the
Pocket PC Data submenu of the File menu. The Export Templates to
Pocket form will be displayed.

A template can be selected by clicking on it with the mouse. To select
additional templates use the Ctrl or Shift key. After the Ok button is
pressed the templates will be exported.

The exported templates will be automatically downloaded to the
Pocket PC during synchronization.
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Export Templates to Pocket
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3.3 Downloading Lithology Macros

To export and download the lithologic macros in WinLoG to Pocket
WinLoG, select the Export Lithologic Macros menu item from the
Pocket PC Data submenu of the File menu. All of the lithologic
macros will be exported. These macros will be automatically down-
loaded to the Pocket PC during synchronization.
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3.4 Downloading Well Macros

To export and download the well macros in WinLoG to Pocket
WinLoG, select the Export Well Macros menu item from the Pocket PC
Data submenu of the File menu. All of the well macros will be export-
ed. These macros will be automatically downloaded to the Pocket PC
during synchronization.

4.0 How to ...

4.1 Create and Open Projects

To create a new project, select the New Project menu item from the File
menu. A new project form will be displayed where you can enter the
project name (up to 100 characters). This name must be unique.

To assist the entry of a unique name a list of all of the existing projects
is displayed.

To open an existing project, select the project from the open project
form that is displayed when the program is started or when the current
project is closed. The project can be selected by touching it with the
stylus. When the project is opened a list of existing logs in the project
will be displayed.

4.2 Create a New Boring Log

To create a new boring log in the current project select the New Log
menu item from the File menu. A new log form will be displayed where
you can enter a unique name for the log (up to 100 characters).

To assist you in specifying a unique name, a list of existing logs in the
project is displayed.
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After the unique name is entered and the Ok button is pressed the
Select Template form will be displayed. Select a template to use for
the log by clicking on it. The template determines the types of data
included in the log. These templates are created on the desktop version
of the program and downloaded to the Pocket PC.

When the boring log is created a menu tree will be displayed showing
the different types of data that can be entered. The boring log data can
be entered and edited by selecting the data type from the menu tree.

If the New Log menu item is not available make sure that a project is
currently open and that no boring log is opened.

4.3 Download Templates and Macros

To export and download the templates or macros in WinLoG to Pocket
WinLoG, select the appropriate export menu item from the Pocket PC
Data submenu of the File menu. These templates or macros will be
automatically downloaded to the Pocket PC during synchronization.

4.4 Upload Boring Logs

The uploading of data from the Pocket PC to the desktop is performed
automatically during the synchronization process. To import the
uploaded data into WinLoG, run WinLoG and select the Import Logs
menu item from the Pocket PC Data submenu of the File menu. The
Import Pocket PC Data form will be displayed. This form shows the
projects and the logs for each project on the Pocket PC.

If the data is to be imported into a new project, the New Project form

will be displayed after the button is pressed. Enter the project infor-
mation and press the Ok button to import the data.
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If the data is to be imported into an existing project, the Open Project
form will be displayed after the button is pressed. Select the project and
press the Ok button to import the data.

4.5 How to Set Defaults for the Program

Defaults are used in the program to assist in entering data quickly and
easily. These defaults can be changed by selecting the Preferences
menu item in the File menu.

The following information can be entered on the Preferences form:

WinLoG Dir: This is the directory on the Pocket computer where the
WinLoG data is stored. Usually the “Winlog” subfolder of the “My
Documents” folder. Normally, this directory is created when the pro-
gram is installed and does not need to be changed.

Library: This is the default lithology library to use when adding litho-
logic layers.

Depth Increment: This is the default depth increment to use when
entering depths. The depth increment is used for the up and down but-

tons to the right of depth fields.

Lithology Macro Title: Check this box to have the lithologic
title/name of a layer updated when a lithologic macro is chosen.

Lithology Macro Symbol: Check this box to have the lithologic sym-
bol of a layer updated when a lithologic macro is chosen.

Sample Length: This is the default sample length to use when a sam-
ple is added to a log.
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Sample Symbol: This is the default symbol to use when a sample is
added. When the symbol button is clicked a list of symbols will be
displayed.

Sample Type: This is the default sample type to use when a sample is
added.

Well Diameter: This is the default well diameter to use when a new
well is added.

Well Pipe Thickness: This is the default pipe thickness to use when a
well component is added.
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